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Safety and Regulatory 
Compliance
The Gel DocTM EZ imager is intended for laboratory use only. This instrument is meant for 
use only by specialized personnel who know the health risks associated with the reagents 
normally used with this instrument. 

The UV light source is computer controlled, and proper interlocks are implemented to 
avoid users’ accidental exposure to UV radiation.

If the Gel Doc EZ imager is used in a manner not specified by Bio-Rad Laboratories, the 
protection provided by the Gel Doc EZ imager may be impaired.

To help you make informed decisions about safety, we have provided comprehensive 
operating procedures and safety information in this manual and on labels affixed to the 
imager. This information will alert you to any potential hazards. It is the user’s 
responsibility to read and understand the safety information and use it for safe operation 
of the system.

Safety Use Specifications and Compliance
The Gel Doc EZ imager is designed and certified to meet EN61010, the internationally 
accepted electrical safety standard, and EN61326 Class A EMC regulations. Certified 
products are safe to use when operated in accordance with the instruction manual.

This instrument should not be modified or altered in any way. Modification or alteration of 
this instrument will:

• Void the manufacturer’s warranty 
• Void the regulatory certifications 
• Create a potential safety hazard

 Gel Doc EZ imager certification label
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For easy customer access, the serial number information appears in two locations on your 
instrument: on the back panel and inside the front door.

Instrument Safety Warnings
Notes, cautions, and warnings are used to highlight certain operating procedures and 
recommendations. The table below describes how each is used in this document.

NOTICE

The Gel Doc EZ imaging system is intended for laboratory use only. This system is meant 
for use by specialized personnel who know the health risks associated with reagents 
normally used in electrophoresis. The UV light source is computer controlled, and proper 
interlocks are implemented to avoid users’ accidental exposure to UV radiation. Bio-Rad 
Laboratories, Inc., is not responsible for any injury or damage caused by use of this 
instrument for purposes other than those for which it is intended or for instrument 
modifications not performed by Bio-Rad Laboratories, Inc., or an authorized agent.

WARRANTY

Each Gel Doc EZ imaging system is protected by a comprehensive instrument warranty 
agreement. Please read this manual thoroughly so that you fully understand the coverage 
provided and are aware of your rights and responsibilities. One of the responsibilities of 
system ownership is regular maintenance. Following the maintenance instructions 
provided with this manual will help keep your system and peripherals functioning optimally 
and will protect your investment. Please also keep in mind that Bio-Rad offers a range of 
comprehensive service agreements that can be tailored to meet your specific needs. Bio-
Rad Laboratories is dedicated to your total satisfaction and will be pleased to answer any 
questions you may have.

Notes, Cautions, and Warnings

Icon Meaning

Note: Note: A note indicates a special procedure, an exception to normal 
operation or something else of specific interest to the reader. Notes are 
preceded by the word Note. 

Caution: A caution precedes an operational step that could damage the 
instrument or destroy data unless the operator takes certain precautions. 
Cautions located in the main text are preceded by the word Caution and 
are accompanied by the Caution symbol in the left margin.

Warning: A warning precedes an operating procedure that could cause 
injury to the operator if not followed correctly. Warnings located in the main 
text are preceded by the word Warning and are accompanied by the 
Warning symbol in the left margin.
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CAUTIONS

WARNINGS

Caution: With the exception of cleaning or replacing light bulbs, 
refer all servicing to qualified Bio-Rad personnel or their agents. If 
you experience technical difficulties with the instrument, contact 
Bio-Rad to schedule service. The instrument should not be 
modified or altered in any way. Alteration voids the manufacturer’s 
warranty and may create a potential safety hazard for the user.

Caution: If the case interlock is defeated, there is a possibility of 
UV-B radiation hazard due to UV-B light exposure. Caution must 
be exercised when servicing the instrument. 

Caution: Bio-Rad is not responsible for any injury or damage 
caused by the use of this instrument for purposes other than that 
for which it is intended, or by the modification of this instrument 
when not performed by qualified Bio-Rad personnel or their 
agents.

Caution: Disconnect the AC power cord before removing the instrument 
cover.

Warning: This instrument must be connected to an appropriate AC 
voltage outlet that is properly grounded.

Warning: There are hazardous voltages on the inside of the  
Gel Doc EZ. Do not remove the system cover when the instrument 
is connected to AC power.

Warning: Do not defeat instrument interlocks; they are designed to 
prevent user injury.

Warning: The Gel Doc EZ imager contains high voltage circuits. 
The user must disconnect the power cord prior to opening the 
system cover or removing the lamp modules for bulb replacement.

Warning: It is mandatory for users to turn off the imager and 
disconnect AC power from the unit before performing disassembly, 
as is needed to replace the lamps.

Warning: Do not remove the instrument cover when power is supplied to 
the instrument or defeat the UV safety interlock. Attempting to operate the 
unit with the cover removed may damage the instrument and expose the 
operator to hazardous voltages and UV radiation.

Warning: Use of controls or adjustments or performance of procedures 
other than those specified herein may result in exposure to hazardous UV 
radiation.
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1 System Overview
Thismanual describes the Gel Doc™ EZ system, which consists of the Gel Doc 
EZ imager and Image Lab™ software.

The Gel Doc EZ system supports multiple applications, including Coomassie 
and ethidium bromide staining, blue excitation for nondestructive DNA 
visualization, and stain-free gel imaging. 
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When coupled with the stain-free gel tray, the Gel Doc EZ system represents 
the next generation in stain-free imaging. It features one button acquisition, 
yields quick results with higher image quality, and is so simple to use it 
requires no training, even for users who are not familiar with image analysis 
systems. The Gel Doc EZ system’s compact size frees up benchspace for 
running your experiments.

The Gel Doc EZ system is a reproducible and fast label-free SDS-PAGE/native 
PAGE system that eliminates time-consuming staining and destaining steps. 
Image Lab image acquisition and analysis software works with the Gel Doc EZ 
imager to create an automated and time-saving system to image and analyze 
electrophoresis gels. Data can be viewed, modified, and reported using Image 
Lab software.

Image Lab software protocols can automate gel image acquisition, analysis, 
and report generation at the push of a single button on the imager.

Researchers can run default protocols or easily design their own custom 
protocols. Image Lab software enables you to view analyzed data, adjust the 
analysis, and produce customized reports that show precisely the settings 
that were applied, assuring repeatable results.
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Gel Doc EZ Imaging System
The Gel Doc EZ imaging system is a dedicated low-noise detection camera 
and UV transilluminator–based system with a small footprint. Designed for 
economy, automation, and ease of use, the user interface consists of a set of 
four sample trays and a one-touch button to image your gel using a protocol. 

Gel Doc EZ imaging system, catalog #170-8270
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Four sample trays are available for the Gel Doc EZ imaging system. Each tray 
supports a different set of applications, as shown in the table. 

Sample Tray Types and Applications 

UV Tray
Catalog #170-8271

White Tray
Catalog #170-8272

Blue Tray
Catalog #170-
8273

Stain-Free Tray
Catalog #170-
8274

Ethidium bromide Fast Blast™ DNA 
stain

SYBR® Green Stain-free gels

SYBR® Green Coomassie Blue 
stain

SYBR® Safe Stain-free blots

SYBR® Safe Copper stain SYBR® Gold

SYBR® Gold Zinc stain GelGreen

GelGreen Silver stain

GelRed

Flamingo™ 
fluorescent gel stain

Oriole™ fluorescent 
gel stain

Coomassie Fluor 
Orange

SYPRO Ruby

Krypton
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Image Lab Software Capabilities
Image Lab software runs automated protocols on the Gel Doc EZ system for 
routine gel imaging documentation and analysis.

GEL DOCUMENTATION

Gel electrophoresis is a common way to separate, identify, and purify proteins 
or nucleic acids. The Gel Doc EZ system enables you to image and print gel 
images for documentation in laboratory notebooks or to export images for 
publication or presentation.

MOLECULAR WEIGHT ASSESSMENT

SDS-polyacrylamide gel electrophoresis (SDS-PAGE) and agarose gel 
electrophoresis are used to separate proteins or nucleic acids according to 
their size. Protein or nucleic acid molecular weight standards provide a 
reference for estimating the molecular weight of the proteins or nucleic acids 
being tested.

QUANTIFICATION

The components in a sample (bands) are quantified to determined relative 
amounts of each component in a sample or to compare the amount of a 
sample component relative to a standard. Assessing the purity of a sample 
requires the quantification of all components of a sample relative to each 
other. The results are expressed either as a percentage of all bands identified 
(band %) or as a percentage of all signal in the sample lane (lane %). 
Determining expression levels of a protein or nucleic acid requires 
quantification among samples. Data can be reported as either relative values, 
if the quantity is unknown, or as an absolute value, if a standard of known 
quantity is present.
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2 Configuring the System 
Configuring the system requires the following steps, all of which are described 
in this chapter:

1. Install Image Lab™ software on the PC or Mac computer you intend to 
use with the imager.

2. Connect the Gel DocTM EZ imager to the computer.

3. Configure the imager.

Steps 1 and 2 are described in detail in the Gel Doc™ EZ Installation Guide. 
This topic walks you through the wizard steps for configuring the imager.

Installing Image Lab Software

Windows 
1. Place the Image Lab software CD in your CD-ROM drive. The 

installation should start automatically. If it does not, open My Computer 
and click the CD drive icon. 

2. Double-click setup.exe. The setup program installs Image Lab software 
on your computer.

The Image Lab software icon appears on your desktop. Follow the 
instructions in the next section to connect your system.
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Mac
1. Place the Image Lab software CD in your CD-ROM drive.

2. Double-click the CD icon on your desktop to see the folder contents. 

3. Double-click the file Image Lab.dmg.

4. Drag the Image Lab application icon into the Applications folder.

Follow the instructions in the next section to assemble your system.

Connecting the Imager to the Computer
1. Install or upgrade the Image Lab software before connecting the Gel 

Doc EZ imager to a computer. 

2. Connect the imager to the computer using the USB cable provided with 
the system.

3. Connect the Gel Doc EZ imager to AC power using the power cord 
provided. 

USB cable

Rear of imager

Computer

AC

Power
cord



Connecting the Imager to the Computer

9

4. Turn on power to the imager using the switch on the side of the 
instrument. 

If Your Computer is Running Windows XP
After the power is turned on, the PC automatically recognizes the imager, and 
the software prompts you to install the drivers. The screen below appears:

5. Select No, not this time, and then select Next. 

Power
switch
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The following screen appears:

6. Install the software automatically is selected by default.  
Click Next. 

The following screen appears:

7. Click Continue Anyway. Windows installs the driver.
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8. Click Finish when it appears. A message appears briefly in the lower 
right corner of the screen: Your new hardware is ready to use.

Note: Windows XP may prompt you to go through the driver 
installation a second time. If this happens, repeat steps 5  
through 8 until you receive the message “Your new hardware is 
ready to use.”

WINDOWS 7
During the installation process the following warning may appear. This 
warning can be ignored because it appears even when the driver has been 

installed correctly.

Configuring the Imager
To use the imager with Image Lab software, the imager must first be 
configured. Imager configuration consists of initializing the sample trays and 
collecting the dark image. 

The imager is configured in the setup wizard, which appears the first time the 
imager is connected to a computer.

To configure the imager:
1. Turn on the imager and start Image Lab software. The setup wizard 

appears. 

2. Complete the steps in the wizard, which are described next.

Note: You must go all the way through the wizard or the imager will 
not be usable.
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The first page of the setup wizard 
indicates that a new instrument has 
been found on the system and displays 
the instrument’s serial number.

1. Click Next.

The Dark Image Correction page 
appears. Correcting the dark image 
reduces dark current noise generated 
from the charge-coupled device (CCD). 
Dark current noise is typical of all CCDs 
and is a result of the accumulation of 
charge in the absence of light.

2. If a tray is in the imager, remove it 
and close the tray door.

3. Click Acquire Dark Image.

A progress indicator reports the 
acquisition of the dark image.

When the dark image has been 
acquired, the wizard prompts you to 
initialize the UV tray. 

4. If you do not have a UV tray, click 
Skip and go to step 7.

5. Make sure the UV tray is clean. Then 
insert the tray into the imager and close 
the door.

A progress indicator reports the 
initialization of the tray.
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When the tray has been initialized, the 
next page confirms that the tray has 
been found and initialized and lists the 
applications you can run with this tray. 

6. Remove the UV tray from the imager. 
Then click Next.

The wizard prompts you to initialize the 
white tray. 

7. If you do not have a white tray, click 
Skip and go to step 10.

8. Make sure the white tray is clean. 
Then insert the tray into the imager and 
close the door.

A progress indicator reports the 
initialization of the tray.

When the tray has been initialized, the 
next page confirms this and lists the 
applications you can run with the tray. 

9. Remove the white tray from the 
imager. Then click Next.
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10. The wizard prompts you to initialize 
the blue tray. If you do not have a blue 
tray, click Skip and go to step 13.

11. Make sure the blue tray is clean. 
Then insert the tray into the imager and 
close the door.

A progress indicator reports the 
initialization of the tray.

When the tray has been initialized, the 
next page confirms this and lists the 
applications you can run with the tray. 

12. Remove the blue tray from the 
imager. Then click Next.

13. The wizard prompts you to initialize 
the stain-free tray. If you do not have a 
stain-free tray, click Skip and go to step 
16.

14. Make sure the stain-free tray is 
clean. Then insert the tray into the 
imager and close the door.

A progress indicator reports the 
initialization of the tray.



Connecting the Imager to the Computer

15

See Chapter 4, Acquiring Images to configure the default protocols that run 
when the green button on the imager is pressed.

When the tray has been initialized, the 
next page confirms this and lists the 
applications you can run with the tray. 

15. Click Next.

A tray summary page lists all the trays 
and their status. Trays you initialized 
appear as ready to use. 

16. Click Finish to exit the wizard.



Gel DocTM EZ System | Configuring the System

16

Initializing an Additional Tray
After you configure the imager, you can add another tray to the system when 
you need it. 

To initialize an additional tray:
1. Insert a new type of tray in the imager. The New Tray Found wizard 

opens.

2. Complete the steps in the wizard.

The wizard identifies the new tray 
and asks whether you want to 
initialize it.

1. Click Next.

The wizard begins initializing the tray.
A progress indicator reports the 
initialization of the tray.

When the tray has been initialized, 
the wizard displays a list of the 
applications you can run using the 
tray.

2. Click Next.
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The wizard displays the Tray 
Summary, which shows the 
highlighted, initialized new tray.

3. Do one of the following:

Click Finish to leave the wizard and 
display the Default Protocol Setup 
window, where you can start creating 
a default protocol for the new tray.

Or

Clear the checkbox at the bottom of 
the wizard page to skip setting up a 
default protocol. Then click Finish to 
leave the wizard.
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3 Image Lab Software 
Overview
Image Lab image acquisition and analysis software works with the Gel DocTM 
EZ imager, stain free gels, and other gels that are not stain-free to create a 
reproducible, automated, and time-saving workflow for imaging and analyzing 
gels. 

In Image Lab software, a protocol is any combination of imaging, analysis, 
and report settings that has been saved to run as a single workflow. 
Researchers can run one protocol repeatedly or easily design a wide range of 
protocols. 

With Image Lab software you can view analyzed data, edit the analysis, and 
produce customized reports that show the precise settings that were applied 
to ensure repeatable results. 

Two types of files are generated by Image Lab software:
• Protocol files describe the parameters for imaging and analyzing 

gel images. Protocol files are saved with a .ptl extension
• Image files contain the imaged gel, annotations, and analysis 

performed on the gel. Image files are saved with an .scn extension 

An imaged gel, run according to a protocol file, generates an image file. 
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Imaging Process Overview 
You can image your gel on the Gel Doc EZ imager by running a default 
protocol or a custom protocol. You can set up default protocols for the gels, 
applications, and analyses you are likely to run repeatedly. Then you can 
access them with a touch of a button on the front of the imager. For gels and 
applications you run less frequently, you can set up custom protocols that you 
can call and run with a software command. Both default and custom 
protocols can be saved and reused.

Default Protocols
Image Lab software supports four default protocols, one for each type of 
available sample tray. First, set up a default protocol for the kind of application 
you want to run. Then, run the default protocol, which activates and images 
the gel with one touch of a button. See Setting Up a Default Protocol, on 
page 33 for detailed instructions. 

To run a default protocol:
1. Open the imager door and remove the sample tray.

2. Place your gel on the sample tray and insert it 
into the imager until the magnet grabs the tray.

3. Close the door. 

4. Press the green Run button on the front panel of 
the imager. The default protocol runs 
automatically.

Run button
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Custom Protocols

You can set up additional custom protocols based on your exact 
requirements. Setting up a custom protocol is similar to setting up a default 
protocol. 

To run a custom protocol:
1. Open the imager door and remove the sample tray.

2. Place the gel on the sample tray and insert it into the imager until the 
magnet grabs the tray.

3. Close the door.

4. Click New in the Protocols box on the Image Lab Start Page, or click 
New Protocol in the toolbar. 

5. Select the parameters for your protocol. See Running a Custom 
Protocol, on page 47 for detailed information.

6. Click the green Run Protocol button in the left pane of the Protocol 
Setup window to run the protocol.

Using the protocol you specified, the software controls the imager to 
activate the sample, analyze the image, and then generate and print a 
report.
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Interface Overview
The following screen shows the Image Lab software main window. The 
paragraphs below describe the main software elements.

Main Window
Image Lab software displays a single main window. All image and protocol 
windows that present choices open in the workspace, which is the gray area 
of the main window. 

If many screens are open in the workspace, you can make one visible by 
clicking the title bar at the top of the selected screen. A list of open protocols 
and image files also appears in the Window menu; you can select one to bring 
it to the top.

You can view the complete analysis for an image or protocol at one time or 
compare image results by arranging the screens in the workspace.

 

Toolbar

Analysis
Start page

Workspace

Status bar

Menus 

toolbox
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Toolbar
Many Image Lab software tools can be selected by clicking toolbar icons. The 
Screenshot tool enables you to send a screen capture of your image to the 
clipboard or to save it as a file. You can view demonstrations of various 
functions by clicking Tutorials. The unlimited Undo and Redo buttons enable 
you to correct missteps easily. 

Clicking the green Default Protocols button at the right end of the toolbar 
displays the Default Protocol window for setting up, viewing, and editing 
default protocols.

Additional tools for viewing protocols and results data presented in various 
forms are labeled below. These tools are described in detail in Chapter 5, 
Viewing Images, on page 49.

Results Data
Results data associated with gel images can be viewed as an analysis table, a 
lane profile, a standard curve, or in a report. These views always display the 
analysis for the selected image. 

Buttons to toggle these views on and off are located in the main toolbar. All of 
them can be viewed at once. See Displaying Data, on page 56 for details.

File management View results data
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Display Toolbox
The Display Toolbox near the top of every image enables you to display your 
images in the most useful ways. See Displaying Gel Images, on page 50 for 
details.

Start Page
The Start Page guides you through creating, opening, and viewing protocols 
and images.

Analysis Tool Box
The Auto Analysis button quickly analyzes images. The remaining tools 
customize the analyzed data.

Note: An image file must be selected (on a Windows computer, 
the title bar is dark blue) to make analysis tools available.
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Image Tools enable you to flip, rotate, and crop images, and to transform the 
image files. 

Lane and Band controls the detection function, enabling you to resize, adjust, 
and bend lanes, and to detect, adjust, add, or delete bands.

MW (Molecular Weight) Analysis Tools enable you to choose standard 
samples, assign standard lanes, and choose a regression method.

Quantity Tools enable you to automatically quantitate bands using either 
relative or absolute values.

Annotation Tools are useful for drawing attention to any area of a gel of 
interest. 

Volume Tools enable you to manually quantify an object inside a boundary 
that you define. 

Analysis tools are described further in , on page 63.
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Status Bar
The status bar in the lower right corner of the main window shows the tray and 
imager in use and the X and Y values for the cursor position on an image file.

If a default protocol has been set up for the tray in use, its name also appears 
in the status bar next to the tray name. The Int (intensity) value shows a 
numerical value for the image intensity at the mouse position. The maximum 
data range using the Gel Doc EZ imager is 0–4,095, but the ranges vary 
depending on the values contained within each image.

Menu Commands
The following section describes all menu commands in the File, Edit, View, 
Window, and Help menus. Many commands are also available on the toolbar 
or the Start Page.

File Menu Commands
New Protocol enables you to create a new protocol that contains the 
necessary steps and choices. See Chapter 4, Acquiring Images, on page 31, 
for detailed instructions. Protocols can also be altered and stored for reuse. 

Open browses your file system to retrieve a previously saved protocol file or 
image file.

Recent Images gives you the choice of opening a recent image file.

Recent Protocols gives you the choice of opening a recent protocol.

Save enables you to save a protocol or image file once the protocol or image 
is named.

Save As enables you to name and store a protocol or image. Protocols are 
stored with a .ptl file extension. Image files are stored with an .scn extension.

Close closes the active screen.
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Close All closes all the screens.

Export enables you to export gel images or analysis tables with the following 
options:

• Export for Publication—exports a displayed image to a file. You 
can select from .bmp, .png, .jpg, and TIFF formats. The gel 
displays with any lanes, bands, and annotations that appear on the 
screen. See Exporting Gel Images for Publication, on page 90 for 
more information

• Export for Analysis—creates a TIFF formatted file that retains all 
gel image data. Analysis data are not included. Use this option to 

analyze the image in other software such as Quantity One, 

FPQuest™, or InfoQuest™FP. See Exporting Gel Images for 
Analysis, on page 91 for more information

• Export for PulseNet—reduces the image to an 8-bit TIFF image 
file. Resolution is limited and file size is restricted to 300 dpi

• Lane and Band Table to Excel—if Excel (or Numbers, on a Mac) is 
installed on your computer, it launches with your lane and band 
table displayed as a spreadsheet

• Lane and Band Table to File—exports as a CSV (comma-
separated values) file so your lane and band table can be opened in 
a database application

• Volume Table to Excel—if Excel (or Numbers on a Mac) is installed 
on your computer, it launches with your volume table displayed as 
a spreadsheet

• Volume Table to File—exports as a CSV (comma-separated 
values) file so your volume table can be opened in a database 
application

See Chapter 8, Exporting Results, on page 89 for detailed information about 
exporting files.

Image Info displays information about individual gel and blot images such as 
acquisition date, data range, and image capture details such as the exposure 
time and illumination source used in three tabs (Image Details, Analysis 
Settings, and Notes).
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Page Setup contains print controls such as orientation (landscape or portrait), 
margins, printer used, and paper size.

Print displays a print preview of the gel and the header information, which 
includes the filename of the image, the user’s name, and date and time it was 
printed. The usual Windows Print screen is available as well; it enables you to 
select a printer and the number of copies.

Exit closes Image Lab software (after asking you to save changes to your 
protocols or images). 
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Edit Menu Commands
Undo undoes your last action.

Redo restores your last action after an Undo.

Screenshot enables you to take a screen capture of the Lane Profile Window, 
the Standard Curve Window, or the default choice, Current Image View. This 
capture can include the name of the image, and it can be placed on the 
clipboard or saved in a file.

Default Imager enables those who own two or more different model imagers 
to switch among them.

Instrument Setup enables you to review the instrument name and serial 
number, camera serial number, firmware version, and the flat field version. 
Available sample trays are shown with the names of associated default 
protocols. Dark Image time and date are also shown. You can reset the dark 
image. You can reset the flat field only for the white sample tray.

Report Settings enable you to configure reports. This dialog box displays 
three tabs. All the checkboxes are selected by default; clear the boxes for 
information you do not want to include in reports. Your selections apply to all 
reports until you change them again.

• The General tab has options for excluding or reporting information 
about the gel image

• The Lane and Band Table tab enables the researcher to choose 
whether to include all or selected lanes with appropriate identifiers. 
Lane profiles can also be included

• The Volume Table tab enables you to choose appropriate identifiers 
for the volume table and provides the option of excluding the table 
from reports

Preferences displays two tabs.
• The Protocol tab shows presets for naming your image files. You 

can choose to include a designated Prefix, User Name, Date and/
or Time in the name of your image files

• The Colors tab enables you to choose colors for the graphic 
elements in your gels such as Lane Frame, Lane, Band, Band 
Attribute, and MW Legend. This functionality ensures that these 
elements are visible, regardless of the color of the gels
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View Menu Commands
Image Overview opens a small window that shows the entire gel image with 
a red rectangle outlining the area visible in the larger main window. This is 
useful when you zoom into a small section of your image.

Image Transform opens a window showing a histogram you can use adjust 
the light and dark values of your gel image. This adjustment does not change 
your data, only the way the data display on your monitor.

Operations History opens a window showing the sequence of actions 
performed.

Window Menu Commands
The Window menu controls enable you to show and hide multiple open image 
files in your workspace. A list of all currently open images and protocols 
displays in this menu.

Tile aligns all open image files so all are visible at once.

Tile Horizontal places all open image files from top to bottom.

Tile Vertical places all open image files from left to right.

Cascade stacks all open image files and protocols with overlapping title bars 
so that each one can be easily chosen for view.

Imitate Zoom changes the zoom setting of all open images to the same zoom 
setting as the current image file.

Imitate Transform changes the brightness and contrast of all open images to 
the same transform settings as the current image file.

Next cycles through all open image files from oldest to newest.

Previous cycles through all open image files from newest to oldest.

Help Menu Commands
Image Lab Help displays the help system. 

User Guide displays this instruction manual in .pdf form.

About displays Image Lab software version information and release date.
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4 Acquiring Images
Acquiring an image requires a set of steps in a workflow called a protocol. In 
Image Lab software, a protocol can include any combination of settings for 
imaging, analyzing, and reporting that has been saved to run as a single 
workflow. 

Users can link a protocol to a tray type by default. Such a default protocol is 
associated with: 

• A specific type of sample tray

• The green Run button on the front of the Gel DocTM EZ imager
• The user’s computer system login ID

The advantage of a default protocol is that it can be run with a single press of 
the green Run button on the imager. Custom protocols are run by clicking a 
software button in Image Lab software. In all other respects, default protocols 
and custom protocols are similar. 

Typically, a default protocol is set up for the applications you run most often 
with a particular tray. Each user can set up four default protocols (one for each 
type of sample tray) to run applications. A custom protocol can be set up for 
less frequently run applications to capture the setup steps for later use.

Once set up in Image Lab software, a default protocol is run by placing a gel 
in a sample tray, inserting the sample tray, and pressing the green Run button 
on the front of the imager. The imager automatically runs the default protocol 
assigned to the type of sample tray you inserted.

If you have only one sample tray, it will automatically be considered the default 
sample tray. For example, suppose you have only a blue tray. Once the blue 
tray has been associated with the imager, Image Lab software will list all 
applications that can run on the blue sample tray. 
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Selecting a Sample Tray
The following tables list preset applications and the appropriate sample tray to 
use with each. Refer to these tables to select a sample tray for your 
application. If your application is not listed here and you are unsure of the 
appropriate sample tray to use for your application, contact Bio-Rad Technical 
Support for assistance.

Applications for Nucleic Acid Gels

Applications for Protein Gels

*Recommended for imaging only.

Detection Reagent
Primary 
Tray

Alternate 
Tray

Ethidium bromide UV None

SYBR® Green Blue UV

SYBR® Safe Blue UV

SYBR® Gold Blue UV

GelGreen Blue UV

GelRed UV None

Fast Blast™ DNA stain White None

Detection Reagent Tray

Stain-free gels Stain-free

Stain-free blots Stain-free

Coomassie Blue stain White

Copper stain White

Zinc stain* White

Flamingo™ fluorescent gel stain UV

Oriole™ fluorescent gel stain UV

Silver stain White

Coomassie Fluor Orange UV

SYPRO Ruby UV

Krypton UV
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Setting Up a Default Protocol
Setting up a protocol consists of three major processes: 

• Acquisition settings 
• Analyze image
• Report settings 

Each process comprises a set of steps. The appropriate options appear as 
each protocol step is selected. 

Important: You must configure Acquisition Settings (steps 1 
through 6 in the following procedure) to run an application. 
However, it is not necessary to configure Analyze Image and 
Report Settings unless you want to calculate the molecular 
weight automatically and generate a report.

To set up a default protocol:
1. Click the Default Protocols button in the toolbar to set up a default 

protocol.

Caution: If the imager is not connected to your computer, 
a message appears asking whether you want to run a 
simulation of the imager. Click No. Turn on the imager. Do 
not set up a protocol in simulation mode. Protocols set up 
in simulation mode cannot be run.
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A Default Protocol Setup window displays each sample tray type as 
well as buttons that enable you to create a protocol or browse an 
existing protocol. Trays that have not been initialized appear dimmed. 
Note that once you create a default protocol, its Create button changes 
to View/Edit so you can review or change the protocol settings.

2. Click Create next to the sample tray type for which you want to create a 
protocol. The first Protocol Setup window appears. The title bar 
identifies the protocol as a default protocol. The imager type and 
sample tray type are also shown. 
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The three major processes are listed in the left pane. Numbered major 
steps in each process appear under these headings. To select options 
under a protocol step, select the accompanying checkbox. Options 
appear in the right side of the window. To disable any step, clear its 
checkbox.

Acquisition Settings

STEP 1. GEL IMAGING

The Gel Imaging checkbox is already selected. The right side of the 
Protocol Setup window displays Gel Imaging options. 
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APPLICATION OPTIONS

3. Select an application: Click Select and choose an application from the 
drop-down menus. 

The menus list only applications appropriate for the selected sample 
tray. When you choose an application, any required filter or illumination 
source displays in the Protocol Setup window.

Note: Custom applications are available only for custom 
protocols. See Setting Up a Custom Protocol, on page 45 for 
more information about custom applications.

4. Set the image exposure 

If you select the first image exposure option, Image Lab software 
acquires an image using the optimal exposure time. This option ensures 
the best use of the dynamic range. You can automatically optimize for 
intense or faint bands.

• If you choose Intense Bands from the drop-down menu, 
exposure is optimized for all bands

• Choosing Faint Bands from the drop-down menu results in a 
longer exposure where faint bands are more visible, but more 
prominent bands may be overexposed

• Select manual exposure to override automated imaging. 
Exposure time can range from 0.001 to 10 sec
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After a gel is imaged with automatic exposure optimization, the used 
exposure time displays in the protocol as a guide so you can manually 
adjust the exposure time if necessary.

You can also view the exposure time of the image later in the Image Info 
window (refer to Image Info, on page 54).

5. Set the Display Options:

Highlight saturated pixels—Select the Highlight saturated pixels 
checkbox to see any saturated pixels in red, which shows how much of 
the gel image is saturated. Saturated pixels are beyond the maximum 
quantifiable range of the imaging system. This option can be changed 
later by selecting View > Image Transform.

Image Color—Select color choice to display the sample image. 
Viewing the image with a different color scheme can make it easier to 
see all of the elements. See Image Colors, on page 53 for the color 
choices.

Analyze Image

STEP 2. DETECT LANES AND BANDS

To analyze the gel automatically, Image Lab software must detect lanes 
and bands on the image. Lanes are detected automatically, and then 
the background is automatically subtracted. Refer to Lane and Band 
Tools on page 68 for details. You can customize band detection with the 
following options.
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6. Select the Lane and Band Detection checkbox in the left pane of the 
Protocol Setup window. The Protocol Setup window displays lane and 
band detection options.

Low Band Detection Sensitivity—This option sets detection at a low 
level for images with prominent bands. Faint bands are not detected.

High Band Detection Sensitivity—This option sets detection at a 
higher level for images that are faint. Extraneous bands can be removed 
later using the Band Tools in the Analysis Tool Box. See Lane and Band 
Tools, on page 68.

Custom—Select a numerical value between 1 and 100 to choose the 
best detection sensitivity for your sample.

Note: When low or high band detection sensitivity is used, these 
numerical values are set: low sensitivity = 25; high sensitivity = 
75.
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STEP 3. ANALYZE MOLECULAR WEIGHT

7. To analyze molecular weight automatically, select Analyze Molecular 
Weight in the left pane of the Protocol Setup window. When this 
checkbox is selected, the software calculates the molecular weight for 
each band based on the specified standard.

8. To estimate the size of the molecules in the bands of your gel, enter the 
standards you are using and specify the lanes in which the standards 
are placed.
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STANDARDS

Determining molecular weight depends upon selection of the proper protein 
standards. Many protein standards are available from Bio-Rad, including:

• Precision Plus Protein™ standard
• Prestained SDS-PAGE standards, broad range
• Prestained SDS-PAGE standards, low range
• Prestained SDS-PAGE standards, high range

Bio-Rad standards cannot be edited. However, these standards can be 
copied, and the copies can be renamed and edited.

The Change button opens the Manage Standards dialog box in which you can 
add third-party standard samples and edit your list.

STANDARD LANES

9. Choose the lane that contains your standards by typing lane numbers 
or the words First and Last in the Standard Lanes field. The format is xx, 
xx, xx, ... where xx is the lane number. For example, if you run an 18-
well gel and want your standards in lanes 1, 10, and 18, enter First, 10, 
and Last.

Note: Lane detection works best when standards are placed in 
the first and last lanes.
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REGRESSION METHODS

A regression method is used to calculate the molecular weight of the unknown 
bands. The software uses the relative front and molecular weight values of the 
standard bands to calculate the standard curve. The standard curve is then 
used to calculate the values of the unknown bands. The shape of the standard 
curve is based on the selected regression method. Choose one of four 
regression methods. 

The methods and the minimum number of standard bands required for each 
type are shown in the following table.

If you do not have enough data points for the selected method, the molecular 
weight of the unknown bands is not calculated.

10. Select the appropriate method for the gel type:
• Gradient gels: The linear (semilog) regression method works 

well for these gels because the mobility of the bands is linear to 
the log of their molecular weight. As an alternative, the point-to-

point (semilog) method can be used if the R2 value is not 
sufficient

• Fixed percentage gels: These gels have a nonlinear 
relationship between the mobility and the molecular weight. For 
these gels, choose the logistic or cubic spline regression 
method

You can check how well each regression method fits the data in the standard 
curve window (for more information, see Standard Curve, on page 60). The 
linear (semilog) regression method provides a measurement that describes 

how well the standard curve fits the data R2 value. The closer the R2 value is 
to 1.0, the better the data fit the standard curve.

The molecular weight of each band is displayed in the Analysis Table in the 
Mol. Wt. column. Refer to page 72 for more information about molecular 
weight.

For information about the calculations behind the regression methods, see 
Regression Calculation Methods.

Regression Method Minimum Number of Standard Bands

Linear (semilog) 2

Point-to-point (semilog) 2

Logistic 5

Cubic spline 5
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Output Settings
Image Lab software prints to the default printer, unless you select otherwise.

You have three choices for specifying output:
• You can automatically print the image; this is useful for gel 

documentation, especially if a thermal printer is connected. See 
Mitsubishi P93/P95 Thermal Printer Settings for instructions on 
setting up the Mitsubishi P93/P95D thermal printer

• You can automatically print the report, including all accompanying 
analysis information

Note: You cannot print a report on a thermal printer. 
• You can display the image on your compute

STEP 4. SPECIFY OUTPUT

11. Select Specify Output in the left pane of the Protocol Setup window to 
display output options.

12. In the right pane, you can choose whether to automatically display or 
print an image or a report after a protocol runs. 

The report can be customized with the options in Edit > Report 
Settings. 

For more information about reporting options, see Generating Reports, on 
page 85.
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Review Protocol Settings

PROTOCOL SUMMARY

13. Click Protocol Summary in the left pane of any Protocol Setup window 
to see a quick review of all protocol settings.

14. Click Save in the left pane to save the default protocol.
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Running a Default Protocol
To run a default protocol:

1. Place a gel on the appropriate sample tray and insert the tray into the 
imager until the magnet grabs the tray.

2. Close the door.

3. Press the green Run button on the front of the imager. The default 
protocol runs automatically.

The default protocol appears with a green background. After the protocol 
runs, the resulting image pops up and the protocol window remains open 
behind it. The application name appears in the status bar below the gel 
preview window.
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Setting Up a Custom Protocol
Creating a custom protocol is similar to creating a default protocol. 

To create a custom protocol:
1. Choose New in the Protocols box on the Start Page or click New 

Protocol in the toolbar. The Protocol Setup window appears.

2. Select an application from the Application drop-down menus. 

The menus list all predefined applications you can run on the Gel Doc 
EZ imager. 

Note: If you want to image a gel using a detection reagent not 
listed in the menus and do not find an equivalent reagent in the 
menus, contact Bio-Rad Technical Support for protocol 
recommendations.
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Choose Custom to run an existing application with a new name or when 
you have an application unlike any existing applications. Selecting 
Custom > Manage Custom Applications in the Application menu 
displays the Manage Custom Applications dialog box. Custom 
applications you save are listed in this dialog box. An Edit button 
enables you to make changes to custom applications.

Note: You cannot create custom applications for the stain-free 
tray.

3. To create a custom application, click New. The Create Custom 
Applications dialog box appears.

4. Enter a unique application name.

5. The remainder of the setup instructions are the same for both default 
and custom profiles. Go to step 4, Set the image exposure in Setting 
Up a Default Protocol on page 34 and follow the instructions there. 
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Selecting a Custom Protocol
Use the same protocol repeatedly by clicking Open in the Protocols box on 
the Start Page or by clicking Open in the toolbar. You can also select recently 
used protocols or image files from the lists on the Start Page.

Running a Custom Protocol
To run a custom protocol:

1. Open a protocol or create a new one. 

2. Place your gel on the appropriate sample tray and insert the tray into 
the imager until the magnet grabs the tray.

3. Close the door.

4. Click the green Run Protocol button in the left pane of the Protocol 
Setup window. The custom protocol runs automatically. 

After the protocol runs, the resulting image pops up and the Protocol 
window remains open behind it. The application name appears at the 
bottom of the gel preview window.
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Editing Protocols
Protocols can be changed or renamed using the many tools in Image Lab 
software.

Open any saved protocol by choosing File > Open or by clicking Open in the 
Protocols box on the Start Page. You will be presented with the same set of 
dialog boxes and choices described in the section, Setting Up a Custom 
Protocol, on page 45. 

Make and save your changes without renaming the protocol to replace an 
older one. Save the edited protocol with a different name to make a second 
protocol.
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5 Viewing Images
Once a gel has been imaged, the image appears in the workspace. Many 
controls are available to optimize viewing and to analyze the image.

Results Overview

The screen shows a gel image with band and lane detection as well as 
annotations. The labels show overlays that you can show or hide. 
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Refer to Display Gel Options on page 50 for more information.

There are many ways to view the data associated with the results. You can 
view data as an analysis table, a lane profile, a standard curve, and as a 
report. 

Displaying Gel Images
Toolbar buttons appear above the gel image. Each of these tools is described 
in the following sections.

Display Gel Options 

ANNOTATIONS

You can choose whether or not to show text and arrow annotations that have 
been drawn on the image.

LANES AND BANDS

You can turn on or off any image overlays, such as lane frames, lanes, bands, 
lane labels, and molecular weight legends.
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BAND ATTRIBUTES

You can show the following attributes for selected lanes or for all lanes.
• Band number
• Band label
• Molecular weight
• Relative front
• Volume
• Abs. Quant.
• Rel. Quant.
• Band %
• Lane %

VOLUMES

If you have drawn volume boundaries on the gel, you can display the volume 
boundaries and their volume labels.

Zoom Tools 
The zoom tools resize the gel image. click the magnifying glass with the plus 
to make the image larger; the minus to make the image smaller.

You can also zoom with the right mouse button. Click and drag to select an 
area you want to magnify. Right-click again to return to the original view.

You can also resize the image with the scroll wheel on your mouse.

Fit in Window 
When you zoom in on an area of an image, clicking this button brings the 
entire image into view.
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Image Transform 

 

Use the Image Transform dialog box to adjust image brightness and contrast, 
optimizing the image display so faint detail can be seen. The minimum to 
maximum range varies, depending on the light and dark values present in the 
image. These adjustments do not change the data; they change only the way 
the data are displayed. The human eye cannot see as great a range as the 
image contains.

The frequency distribution histogram shows the total data range in the image 
and the amount of data at each point in the range.

Auto Scale determines an optimal setting for the image automatically. The 
lightest part of the image is set to the minimum intensity, and the darkest is 
set to the maximum.

• The High progress indicator determines which intensity value is 
shown at the maximum grayscale (or other color) in the gel image

• The Low progress indicator determines which intensity value is 
shown at the minimum grayscale (or other color) in the gel image

• The Gamma progress indicator changes the grayscale curve. A 
value of 1 is linear. A value < 1 redistributes a greater proportion of 
the grayscale to the first half of the intensity values. A value > 1 
redistributes a greater proportion of the grayscale to the second 
half of the intensity values

You can also type numerical values in the text boxes next to the progress 
indicators. Clicking anywhere on the progress indicator bars moves the 
progress indicator incrementally.

Options:
• Invert Image display—Inverts dark bands on a light background to 

light bands on a dark background and vice versa
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• Highlight saturated pixels—When this checkbox is selected, 
areas of the image with saturated signal intensity (above a 
measurable range) are highlighted in red

• Linear or Logarithmic histogram—This adjustment changes the 
y-axis on the histogram to display the number of pixels at each 
intensity value using either a linear or a logarithmic scale

Image Colors 

You can choose a colormap for an image results file. Viewing the image with a 
different color scheme can make it easier to see all of the elements in the 
image, but it does not change the data.

The first eight color choices imitate the colors of stained gels. The remaining 
choices supply enough color variation to highlight small differences in the 
image data. 

Available colors include:
• Gray
• EtBr (Ethidium bromide)
• Coomassie
• Stain Free
• SYBR Green
• SYPRO Ruby
• Flamingo
• Silver
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• False Color
• Spectrum
• Gold-Silver
• Pseudo

3-D Projection 

Clicking 3-D transforms the gel image into a solid 3-dimensional model 
spinning in space with x, y, and z dimensions. Accentuate or diminish the 
relative heights of data points by pulling the slider at the bottom of the window 
to the right or left.

To view the intensity of various bands:
1. Click 3-D in the display toolbox above the image.

2. Click and drag the model to rotate it into your preferred view.

3. Bring the window into focus by clicking the image.

4. Press C to display a green cone, which can be dragged around to 
evaluate the intensity of various bands.

Image Info
The Image Info dialog box provides information about an active image. Click 
Image Info in the display toolbox to display three tabs of information about the 
image.



Displaying Gel Images

55

IMAGE DETAILS

Acquisition and image information appear in this tab.

ANALYSIS SETTINGS

The settings that were used when the gel was analyzed are displayed here, for 
example, Band Detection and Molecular Weight Analysis, if they were 
performed.

NOTES

You can add notes, make custom labels for each of the lanes, point out the 
types of samples used, and add any other information about the results.
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Displaying Data 
The results from analyzed data associated with the gel images can be 
visualized using an analysis table, a lane profile, a standard curve, or a report.

Buttons to toggle these views on and off are located in the main toolbar. All of 
the views can be seen at one time.

Analysis Table 
Numerical data associated with an analysis can be viewed in the analysis 
table. Data from the Lane and Band analysis can be viewed in the Lane and 
Band tab. If volume analysis was performed, this data can be viewed in the 
Volume Table tab.

Clicking Analysis Table opens a tabular display of the data extracted from the 
results. The buttons above the table offer several ways of displaying and 
exporting analysis table data.

SET WINDOW SIZE

To change the size of your Analysis Table window, move to the top of the 
window until the cursor changes into a double-headed arrow. Left-click and 
drag the edge of the window until you can see all of the data.

Note: Resizing the Analysis Table window is restricted when a 
Protocol window is open.

DISPLAY DATA OPTIONS 
This dialog box displays three tabs: Measurements, Display, and Export.



Displaying Data

57

Measurements—Choose the measurements you want displayed by clicking 
the arrow buttons to move them from the Displayed to the Not Displayed field.

Default display settings—Move selected lane to top is on or off, depending 
on whether the checkbox is selected.

Per Measurement Precision—You can set the precision (decimal places) for 
the measurements in both the Lane and Band table and the Volume table.

Example Precision—This field shows how your measurement will display, 
with the number of decimal places you choose in Per Measurement Precision.

Export formatting—This field offers two checkboxes to include lane headers 
(Lane and Band table tab only) and/or column headers in the exported file.

Export delimiter—This field offers three delimiter options for the exported file. 
• CSV (comma-separated values)
• Tab delimited
• Other user-defined delimiter 

CHANGE ANALYSIS TABLE ORIENTATION 
This button toggles between two table orientations.

Horizontal—Displays the lanes/volumes beside each other, so the user can 
scroll through the table from left to right.

Vertical—Displays the lanes/volumes on top of each other, so the user can 
scroll through the table from top to bottom.

COPY ANALYSIS TABLE TO THE CLIPBOARD  
Click this button to copy the analysis table to the clipboard so you can paste 
the analysis table into word processing or presentation applications. It is best 
to use the vertical table orientation when copying to an 8-1/2 x 11-inch page, 
to allow the columns enough room to display.

EXPORT ANALYSIS TABLE TO A FILE  
When exported as a CSV (comma-separated values) file, the data file can be 
opened in a database application.

EXPORT ANALYSIS TABLE TO A SPREADSHEET  
You can use Excel’s sorting and formula functions to manipulate data. If you 
have Excel (or Numbers, on a Mac) installed on your computer, it opens with 
your spreadsheet displayed.
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Lane and Band Definitions
Band Number—each band in a lane has a unique number, sorted from top to 
bottom.

Band Label—you can assign a custom label to each band by clicking the 
Band Label field of the Lane and Band table. 

Molecular Weight—the molecular weight of the band is calculated based on 
the user-defined standard and regression method. Italic values indicate 
extrapolated values. When using nucleic acid gels, the size of the band is 
displayed in base pairs.

Relative Front—values between 0–1 indicate the relative movement of the 
band from top to bottom.

Abs. Quant.—absolute quantification of the band.

Rel. Quant.—relative quantification of the band compared to the reference 
band.

Band %—percentage of the band volume compared to all band volumes in 
the lane.

Lane %—percentage of the band’s volume compared to the entire volume of 
the lane.

Volume Definitions
Volume Number—a unique number is assigned to each volume.

Volume Label—software-generated labels for different types of volumes (U—
Unknown, B—Background, S—Standard) can be changed in Volume 
Properties.

Volume—the sum of all the intensities within the band boundaries.

Adjusted Volume—the background-adjusted volume.

Mean Background—the mean value of the background. 

Absolute Quantity Volume—the quantity of the volume based on the 
standard volumes and the regression method.

Relative Quantity Volume—the ratio of the adjusted volume and the adjusted 
volume of the reference volume.

# Pixels—number of pixels inside the volume boundary.

Minimum Value—intensity of the pixel with the minimum intensity inside the 
volume.

Maximum Value—intensity of the pixel with the maximum intensity inside the 
volume.
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Mean Value—mean value of all pixels inside the volume boundary.

Standard Deviation—standard deviation of all pixels inside the volume 
boundary.

Area—area of the volume in mm2.

Lane Profile 

The Lane Profile option shows a cross-section of the selected lane, rotated 90 
degrees. You can select other lanes by clicking them while the Lane Profile 
window is open.

When the Include Background checkbox is selected, the Lane Profile window 
shows the subtracted background under the blue line. The area used for band 
quantification appears in green under the red line.

You can see the current Rf (relative front) value and the intensity at the cursor 
in the lower-right corner of the Lane Profile screen.

You can change how the bands are labeled by choosing from the options in 
the drop-down list. By default, the bands are labeled with the band number.

SCALE TO FIT GRAPH

You can choose the highest point of the display to define the range of the 
graph. This provides the best view of the lane profile.

You may want to clear the Scale to Fit Graph checkbox to display the entire 
range of possible intensity values in the graph. Doing so allows valid 
comparisons between different lanes.

Background
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INCLUDE BACKGROUND

When you clear the Include Background checkbox, the area of the lane profile 
that represents the background of the image does not display.

IDENTIFY BANDS BY

You can display call outs on the Lane Profile, which indicate these attributes:
• Band Number
• Band Label
• Molecular Weight
• Relative Front
• Volume
• Abs. Quant.
• Rel. Quant.
• Band %
• Lane %

Standard Curve 

The Standard Curve dialog box displays the best curve fit for the defined 
standards and the bands relative to this curve for the lane selected in the 
image. The tabs display the standard curves for three different analyses.
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Standards appear in green; unknown bands appear in red. You can change 
the molecular weight display on the y-axis between linear and log scale by 
clicking the Log y-axis box at the upper left. The regression method you 
chose in Molecular Weight Analysis Tools appears, as well as the formula (if 
applicable) and the R2 value of the regression method.

Tabs in this window display the Mol. Weight Standard Curve, the Abs. 
Quantity Standard Curve, and a Volume Standard Curve.

Report 
See Generating Reports on page 85 for information about reports.
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6 Analyzing Images
Analysis Tool Box tools are enabled once an image file is opened and in focus. 
An active or “in focus” window has a darker blue menu bar on a Windows PC. 
On a Mac, the window control icons display more brightly when a window is 
active. This distinction helps you to identify the active window among many 
open image files in your workspace.

Auto Analysis Settings
Clicking Auto Analysis in the Analysis Tool Box enables you to do the 
following:

• Analyze images that were obtained with protocols that did not 
include steps for detection and analysis

• Change your analysis parameters to reanalyze your images 

Note: If you change any settings for an analyzed gel, the initial 
analysis is overwritten. To preserve both analyses, save the 
image file with a different name.
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DETECTION SETTINGS

Band detection options are as follows:

Low Band Detection Sensitivity—This sets detection at a low level, for 
images with prominent bands. Faint bands are not detected with this setting.

High Band Detection Sensitivity—This sets detection at a higher level for 
images that are faint. Extraneous bands can be removed using the Band Tools 
in the Analysis Tool Box. See Lane and Band Tools on page 68.

Custom—You can set a numerical value between 1 and 100 to select the best 
detection sensitivity for your sample.

When Low or High Band Detection Sensitivity is used, the following numerical 
values are set: low sensitivity = 25; high sensitivity = 75.
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MOLECULAR WEIGHT ANALYSIS SETTINGS

Molecular Weight Standard—Choose any of the many Bio-Rad standards or 
other standards you have placed in your standards list. For more information, 
refer to Standards on page 40. 

Standard Lanes—Choose or change the lanes in which the standards are 
placed. 

Regression Method—Four regression methods are available. For more 
information, see Regression Methods on page 41.

Analysis Toolbox Tools
All Analysis Toolbox tools customize the analyzed data in image files. These 
tools are available only when an image file is open. Click a specific image to 
select among many windows that may be open in your workspace. 

Note: Some tools delete the existing analysis. 

To access a tool:
• Click any of the tool box buttons 

To return to the Analysis Tool Box menu:
• Click the green Up-arrow to the right of the tool name
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Image Tools 
To show the image tools menu, click Image Tools.

 

FLIP 
You can flip the gel image horizontally or vertically.

ROTATE
You can rotate the gel image 90° to the left or right by clicking the Rotate 
buttons. 

To correct a slanted gel:
1. Click Custom. 

2. Rotate the red arrows that appear over the gel to any degree between 
0–360° by dragging them.

3. Right-click the gel image and choose Rotate to set the gel in the new 
position. 

CROP
You can save crop settings and use them to crop other images. This feature is 
useful when you want to crop the same area in several images. 

To crop a gel image: 
1. Click Crop. A red box outlines the image area.

2. Drag the red box to surround the image area you want to keep. 

3. (Optional) Right-click the image to open the Crop menu and click Save 
Crop Settings. 

Click to return
to the
Analysis Toolbox
menu
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4. (Optional) Type a name for the crop settings in the dialog box that 
appears and click OK.

5. Right-click and select Crop or Cancel. Selecting Crop crops the image 
to the area inside the red box.

To crop an image using saved crop settings:
1. Click Crop. A red box outlines the image area.

2. Right-click the image to open the Crop menu and click Load Crop 
Settings. 

3. Select the saved crop settings in the dialog box that appears and click 
Load. The red box resizes and the crop specifications appear on the 
image.

4. Right-click and select Crop. The image is cropped to the area specified 
in the crop settings you selected.

To delete crop settings:
1. With an image open, click Crop. 

2. Right-click the image inside the red box to open the Crop menu and 
click Delete Crop Settings. 

3. Select the crop settings in the dialog box that appears and click Delete.

INVERT DATA

Invert Data is used for negative stains and zymograms. Intensity values of 
bands must be greater than background to perform analysis on the gel. View 
the gel as a 3-D projection to determine if the data must be inverted.

MERGE
Use this button to merge a chemiluminescent blot image with a colorimetric 
image of the same blot. If you have used colorimetric prestained standards for 
a chemiluminescent blot, you can acquire an epi-white light image of the blot 
to show the standards and a chemiluminescent image to show immuno 
detection. These two images can then be merged into a combined image with 
both signals. 

Note: Merging images can have an adverse effect on 
quantitation. If accurate quantitation is required, perform analysis 
on the original, separate images. Only images of the same size 
can be merged.



Gel Doc™ EZ System  | Analyzing Images

68

Lane and Band Tools
Click Lane and Band Tools to select a tab—one to use the lane tools and one 
for band tools.

LANE TAB

You can choose how lanes are detected by selecting Automatic or Manual 
Lane Finder.

• Click Automatic if the gel image is fairly typical
• Click Manual to detect a specific number of lanes or if automatic 

lane detection did not find all the lanes. You can then drag the 
handles on the corners of the red square to resize the lane frame 

ALL LANES

Resize—you can resize all lanes by dragging the handles on the corners of 
the red square to fit the gel image.
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Adjust—if the gel image is irregular, you can adjust the orientation of all lanes 
by dragging a single corner of the lane frame. The Adjust tool does not resize 
the lane width.

You can also add more anchor points on the top or bottom borders of the 
rectangle by clicking the lane frame. Remove any unneeded anchor point by 
right-clicking it. By dragging these anchor points, you can adjust for so-called 
smiling gels.

Delete—you can delete all lanes.

SINGLE LANE

Add—you can add a single lane to a gel image. First click Add, and then click 
within the lane frame where you want to place the new lane. The lanes are 
renumbered.

Note: To add a lane outside the frame, add a lane inside the 
frame and click Move to expand the lane outside the frame’s 
boundaries.

Delete—you can delete a single lane. First click Delete, and then click either 
the lane or its lane number. The lanes are renumbered.

Bend—you can bend a single lane to better fit the gel image. First click the 
Bend button and then drag one of the square anchors to fit the image.

You can add more anchor points within the lane by left-clicking it. Drag these 
anchor points to adjust the lane to fit the gel image. Remove anchor points by 
right-clicking them.

Move—you can move a single lane to a new position on a gel image. First 
click Move, and then click the lane you want to move. Drag it to a new 
location. The lanes are renumbered according to their new position.

Width—you can change the width of a single lane.

LANE BACKGROUND SUBTRACTION

Perform lane-based background subtraction by selecting Enable Subtraction 
in the Background Subtraction field. Use the Lane Profile view to see the 
subtracted lane background.

Rolling Disk—you can specify the size of a hypothetical rolling disk (between 
1–99 mm) that removes background levels along the length of the lane. The 
size of the disk determines how much background is subtracted. 

A large disk follows the profile trace less closely, touching fewer points along 
the trace and removing less background. A smaller disk more closely follows 
the profile trace, removing more background.
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A disk radius that is too large will result in poor background removal. A disk 
radius that is too small may subtract actual data. For most samples, a size of 
<10 mm is usually appropriate. You can perform this task several times until 
you are satisfied with the amount of background removed. Use the Lane 
Profile tool to evaluate the appropriate disc size for background subtraction. 
See Lane Background Subtraction on page 69.

Apply to selected Lane—when you select this box, the level of background 
subtraction specified with the previously described buttons is applied only to 
the selected lane. This option enables you to set different background 
subtraction levels for each lane.

BANDS TAB

This tab enables you to detect bands or reset band detection settings. Click a 
button in the menu, and then click a lane in the image.

Detect Bands—this option opens a dialog box in which you can select band 
detection sensitivity and the lanes to which it applies.
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Add—use this option to add faint bands. First click Add, and then add a new 
band by clicking anywhere inside the lane. 

Note: You can darken your entire image to view faint bands more 
easily using the Gamma slider in the Image Transform dialog box. 
For instructions, see Image Transform on page 52.

Delete — You can delete bands that are not relevant to your analysis. First 
click Delete, and then click any bands you want to remove.

Adjust—you can adjust the height of a band. First click Adjust. Two boundary 
lines appear around each band. Move over a boundary line until you see a 
double-headed arrow. Move the boundary line up or down; the center 
recalculates; the band appears there.

Note: You can also adjust the band boundaries in the Lane Profile 
view.
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Molecular Weight Analysis Tools
Molecular Weight Analysis Tools enable you to determine molecular weight (or 
base pairs, if using nucleic acid gels) by comparing a test sample with known 
standards.

You can view each band’s molecular weight in the molecular weight column of 
the Lane and Band tab in the Analysis Table view or in the gel image by 
selecting Mol Wt. from the Band Attributes section of the Display Gel Options 
window:

MOLECULAR WEIGHT STANDARD

You can change the standards that determine the molecular weight of test 
samples. 

Click Change to access the Manage Standards dialog box, where you can 
choose another standard or add third-party standards. 
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STANDARD LANES

Standard samples are placed in the first and last lanes by default. You can 
specify other standard lanes by selecting the box below each lane or by 
entering the standard lane numbers separated by commas. Standard lanes 
are labeled Std below the lane. 

REGRESSION METHODS

There are four regression methods. See Regression Methods on page 41.

Quantity Tools 
You can quantitate bands in test samples automatically using either the 
Relative or Absolute tabs under Quantity Tools.

RELATIVE QUANTITY TAB

To compare the relative quantities of bands, first select Quantity Tools 
(Relative tab) as shown.
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To select a reference band from an image and quantitate all other bands, 
relative to the reference band:

1. Click the Select button.

2. Click any band you want to use as a reference. A small R for Reference 
appears near the band you selected (see the red circle in the upper left). 

To review the relative band quantities:
• Go to the Rel. Quant. column of the Analysis table (Lane and Band 

tab). The relative quantity is the ratio of the band volume divided by 
the reference band volume

All other bands now display numerical values that are relative to the reference 
band. Values above 1.00 indicate that the band quantity is greater than the 
reference band. Values below 1.00 indicate the band quantity is less than that 
of the reference band.
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ABSOLUTE QUANTITY TAB

Absolute quantification is used to quantify bands based on known standard 
bands using a calibration curve. To determine the absolute quantities of 
bands, first select Quantity Tools (Absolute tab) as shown:

To calculate the absolute quantities of the bands:
1. Click Select.

2. Select at least two standard (known) bands and assign quantity values. 
The values display in the Standard bands table. The greater the number 
of known bands and the wider the range of their values, the more 
accurate the absolute quantity calculation of the unknown bands.

Note: Any standard bands selections can be deleted. To do so, 
select the entry in the Standard Bands field by clicking it and then 
clicking Delete.
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3. Select a unit of measure from the ten choices listed in the Units drop-
down list. 

4. Select a regression method from the three listed in the drop-down list. 

Keep the following guidelines in mind while making your choice.

Linear—This method generates a straight line that is the best fit of the 
values you provided and is preferred in most cases. 

Point-to-Point—This method generates a curve in which each data 
point is connected directly to the next, regardless of the shape of the 
resulting curve.

Cubic spline—This method generates a smooth curve that connects 
each data point. At least four standard points are required to use this 
method of least-squares polynomial fits.

5. Click Standard Curve in the toolbar, select the Absolute Quantity 
Standard Curve tab, and a calibration curve displays. All standards are 

Regression Method
Minimum Number of 

Standard Bands

Minimum Number with 
Force Through Origin 

Option

Linear 2 1

Point-to-point 2 1

Cubic spline 5 4
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represented by green triangles. Unknown values are represented by red 
triangles.

Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.

Note: Clicking the Standard Curve generates a crosshair tool that 
displays the numerical values associated with the placement of 
the cursor in the graph.
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Annotation Tools
You can annotate results with text and arrows to draw attention to areas of 
interest.

ADD ANNOTATIONS

Text—you can add text annotations to gel images to draw attention to 
important details. First click Text, and then click an area you want to 
emphasize. A text box appears with a dotted-line border. Type your comment 
in the text box. Drag the box to change its position.

Note: While editing text, press SHIFT+ENTER to add text. This 
adds a new line in the annotation.

Arrow—to add an arrow, first click Arrow. Click the area where you want the 
arrow to start and then drag to stretch the arrow point to the location you want 
to emphasize. To move the arrow, click the middle and drag it. To change 
where the arrow points, click either end of the arrow. Square boxes appear; 
drag a box to change the length or orientation of the arrow.
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ALIGNMENT

Alignment Icons—these buttons enable you to align multiple annotations, 
such as lane numbers, which you have manually added.

To select annotations—you can select several annotations by holding down 
the CTRL key (Command key on the Mac) and clicking each one or by 
dragging a selection box around them.

To copy annotations—you can copy annotations within or between images. 
First select the annotation you want to copy. Then press CTRL+C to copy and 
CTRL+V to paste the annotations.

TEXT PROPERTIES

You can change the size and type font of your text annotations. To select 
multiple items for change, hold down the CTRL key (Command key on the 
Mac) and click each item.

Font—first click the text box you want to change. Then open the drop-down 
Font list to show all fonts installed on your system. Click one of the font 
names to change the style of the text annotation.

Size—first click the text box you want to resize. Click the up and down Size 
arrows to increase or decrease the size of the text. You can set the font size 
between 6 and 72 points using the drop-down list. 

COLOR

You can change the color of text annotations to make them visible with any 
color scheme and emphasize them further by adding a color to the 
annotation’s background, which is invisible by default. 

To change the color of multiple items, hold down the CTRL key and click each 
item.

Foreground—click a text annotation or arrow. This activates the Foreground 
field so you can use the drop-down list to choose a different color.

Background—click a text annotation. This also activates the Background 
field so you can use the drop-down list to choose a background color.

ROTATE

You can rotate text annotations 90° to the left or right by clicking the Rotate 
buttons.
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Volume Tools
Volume tools enable you to manually quantitate features on a sample image 
when automated lane and band analysis is not appropriate or possible, such 
as in dot blots. 

You can use volume tools to quantitate the signal intensity of bands, spots, 
arrays, and other image data. You define an area of interest by surrounding it 
with a shape. You can choose a rectangle, circle, freehand shape, or lane by 
clicking the buttons under the Volumes field. 

A default label appears within the shape drawn. The volume label can be one 
of three types—U for Unknown, Std for Standard, or B for Background—along 
with a number that is assigned sequentially.
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Each new volume you create initially has a red border, which indicates that the 
volume is selected. When you click elsewhere on the image, the border 
changes to blue, indicating that the volume is no longer selected.

Note: Double-click a volume area to change its properties. 

To review data for the volumes:
• Open the analysis table and select the Volume tab. Volumes are 

listed based on their number and/or the associated information per 
volume. See Volume Definitions on page 58

VOLUME TYPES

You can define the volume type (unknown, standard, or background), the 
quantity of standard volumes, or enter a custom name to replace the default 
label.

Unknown volumes are volumes you want to quantify. 

Standard volumes are used for absolute quantities. See Absolute Volume 
Quantity on page 83. 

Background volumes are used to remove the background from the 
calculation. The result of volume background subtraction appears in the 
Adjusted Volume column of the analysis table (Volume tab).
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VOLUME BACKGROUND SUBTRACTION

When you draw a volume, some non-data background pixels may be included 
inside the volume. These background pixels usually have an intensity value 
that you do not want to include in your volume quantitation. There are two 
ways of calculating this background intensity for your volumes: local and 
global.

Local—local background subtraction calculates a separate background 
intensity for each unknown and standard volume you create. For each volume, 
the intensities of the pixels in a 1-pixel border around the volume are added 
together and divided by the total number of border pixels. This gives an 
average intensity for the background around each, which is then subtracted 
from the intensity of each pixel inside the volume. If the background value is 
greater than the pixel value inside the volume, the background-adjusted 
quantity of the volume may be < 0. In this case, redraw the border for this 
volume.

Global—global background subtraction calculates a single background 
intensity for the entire gel. This average background intensity is then 
subtracted from all the volumes in the gel. The average intensity of the pixels 
in the background volume is calculated and subtracted from each pixel in all 
standard and unknown volumes. Therefore, it is not necessary for the 
background volume area to be the same size as your unknown.

To calculate global background subtraction:
1. Create a volume using one of the volume tools in a representative 

background region of your image (that is, a non-data region similar to 
the background surrounding your data).

2. Double-click the volume. This opens the Volume Properties dialog box.

3. Select the Background option button. 

Notes:
• If you select Global in the Volume toolbox but do not define a 

background volume as described, no background subtraction is 
performed 
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• If you create more than one background volume, all the pixels in 
those background volumes are used to calculate the average 
background. Your background volume(s) will have default names 
B1, B2, and so on based on the sequence in which they were 
created

• If the region you defined as background has a higher average 
intensity value than your data object, you obtain a negative value 
for your adjusted volume in the analysis table. If this happens, 
select a new background region with less intensity than your data 
object

RELATIVE VOLUME QUANTITY

You can choose any one volume as a Reference Volume by selecting the 
Reference Volume checkbox in the Volume Properties dialog box. The 
Reference Volume is indicated by an asterisk on the volume label, for 
example, U1*.

Relative quantities are displayed in the Relative Quantity column in the 
analysis table (Volume tab). The relative quantity is the ratio of the 
background-adjusted volume divided by the background-adjusted reference 
volume.

All other volumes now display numerical values relative to your reference 
volume. Values above 1.0 indicate that the volume is greater than the 
reference volume. Values below 1.0 indicate the volume is less than the 
reference volume.

ABSOLUTE VOLUME QUANTITY 
If you have drawn your volume around an object of known quantity, you can 
use it to calculate the quantity of your unknown volumes. The quantities of 
your unknown volumes are calculated based on the standard volumes and the 
selected regression method.

To classify a particular volume as a standard:
1. Double-click the volume. This opens the Volume Properties dialog box.

2. Select the Standard option button and enter the quantity in the Quantity 
box. 

3. Click OK to close the dialog box. 

Standard volumes will have the default names S1, S2, and so on, based on 
the sequence of their creation. 

To review the regression curve:
• Open the Standard Curve window and select the Volume Standard 

Curve tab
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REGRESSION METHODS

Three regression methods are available to generate the volume quantitation 
curve used for absolute quantity: linear, point-to-point, and cubic spline. To 
display the standard curve, click the standard curve button in the toolbar and 
select the Volume Standard Curve tab in the Standard Curve dialog box. See 
Regression Calculation Methods to learn how each of these methods is 
calculated.

The data for volume standards is found in the Absolute Quantity column of the 
Volume Table. 

Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.

ALIGNMENT

Align volumes by using the appropriate alignment button. To select several 
volumes, CTRL+click each one or drag them to use a selection box.

Copy and paste selected volumes by pressing CTRL-C to copy and then 
CTRL+V to paste. 

When you click Standard Curve in the toolbar, a chart displays all unknown 
and standard quantities.
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7 Generating Reports
After viewing results, you can generate a report that displays the analyzed gel 
images, all of the settings used in the protocol, and as much information 
about the data as you want to include.

The print report settings can be chosen with the Report Settings dialog box in 
the Edit menu or by clicking Report in the main toolbar. 

Report 
Click Report to produce a Print Preview of your report.

Clicking Print prints all of the above information to a printer. 
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Use the following dialog boxes to remove information from reports. Doing so 
does not delete the data from the analysis.

Display Report General Tab
The default setting is for all information to be included. These choices may 
have been made at other stages of the workflow, but you can customize 
reports here.

Clear any of the following checkboxes to exclude information from a report.

Custom Report Title—you can provide a custom report title for the report.

Include Gel Image—the following options determine which overlays display 
on the gel image.

• Show Lanes and Bands
• Show Volumes
• Show Annotations

Image Info
• Acquisition Information
• Analysis Settings
• Image Information
• Notes
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Lane and Band Table Tab

Clear any of the following settings to exclude information from the report.

Include Lane and Band Table

Lanes to show: 
• All lanes or just user-defined lanes
• All lanes on one page, or one lane per page (add page break after 

each lane)

Show Lane Profile—includes the lane profile for each lane.

Move labels to the left—if you do not want these columns to be included in 
the report.
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Volume Table Tab

Include Volume Table—clear to exclude this information from your report.

Move volume labels to the left—if you want to exclude their columns from 
the report.

Print Report 
Click Print Report to print your report. 

PRINT REPORT TO .PDF FILE 
Print Report to .pdf File brings up a Save dialog box so your .pdf file can be 
saved on your system.

ADJUST PRINTER SETTINGS 
Printer Settings accesses options for paper size, orientation, and page 
margins.
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8 Exporting Results
The most convenient way to archive complete information about experiments 
is to produce reports. However, you may want to export only gel images or 

analysis table data for analysis in different programs such as Quantity One, 
FPQuest™, or InfoQuest™FP software. Or you may need exported files for 
presentation or publication. 

Exporting Gel Images
Image Lab™ software includes features for exporting gel images several 
ways. 

• You can export displayed image data to a publication (choose 
Export for Publication) 

• You can export raw image data as a 16-bit TIFF file (choose Export 
for Analysis) 

• You can export image data to PulseNet; doing so reduces the 
image to an 8-bit TIFF file, limits its resolution, and restricts its file 
size to 300 Kb

• You can export lane and band tables as well as volume tables to a 
spreadsheet program or to a file 

The options to export gel images are available using the Export option in the 
File menu.

The available export options are described in the following sections.
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EXPORTING GEL IMAGES FOR PUBLICATION

Use this format only to export visual information to presentation or word 
processing software, such as PowerPoint or Word.

When you select File > Export > Export for Publication, you can export a 
displayed image to a file. You can select from .bmp, .png, .jpg, and TIFF 
formats. The gel displays with any lanes, bands, and annotations that appear 
on the screen.

Note that you can select the entire image or the current view, select the 
resolution or specify a custom resolution, specify the publishing dimensions, 
and view the resulting published image size and dimensions. 

You can zoom in on an area in a current view to export only that area or you 
can export the entire image. You can exclude annotations or overlays by 

clicking Display Gel Options in the toolbar to access the appropriate 
settings.
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EXPORTING GEL IMAGES FOR ANALYSIS

When you select File > Export > Export for Analysis, you can export full image 
data (raw data only) for analysis as a 16-bit TIFF file. 

Note: 16-bit TIFF images are not compatible with all image 
viewers.

The image may require contrast adjustment when it is imported into analysis 
software. This option creates a file that can be analyzed in other programs 
such as Quantity One, FPQuest, or InfoQuestFP software. 

EXPORTING GEL IMAGES TO PULSENET INTERNATIONAL

When you select File > Export > Export for PulseNet, Image Lab software 
reduces the image to an 8-bit TIFF image file. Resolution is limited and file size 
is restricted to 300 Kb. 

Exporting Lane and Band Tables to Excel
If you have Excel (or Numbers, on a Mac) installed on your computer, 
choosing File > Export > Lane and Band Table to Excel opens a table directly 
in Excel. You can then use the Save As option to produce other formats.

Exporting Volume Tables to File
Choosing Export > Volume Table to File exports as a CSV (comma-separated 
values) file so the data file can be opened in a database application. 
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Screenshot Tool Export 
Use the Screenshot tool, available in the toolbar, to capture a displayed image 
to the clipboard or to save it to a file (.bmp, .gif, or .png). 

Analysis Table Export
You can export table analysis data from the File menu or by using the export 
buttons at the top of the Analysis Table window. 

The Analysis Table window has several buttons to export data to different 
formats, depending on how the data are to be presented.

COPY ANALYSIS TABLE TO THE CLIPBOARD 
Click this button to copy the analysis table to the clipboard and to paste the 
analysis table into word processing or presentation applications. It is best to 
use the vertical table orientation when copying to an 8-1/2 x 11-inch page to 
accommodate the columns.

EXPORTING ANALYSIS TABLE TO A FILE 
This button exports an analysis table as a CSV (comma-separated values) file 
so your data file can be opened in a database application.

EXPORT ANALYSIS TABLE TO A SPREADSHEET 
This button enables you to use Excel’s sort and formula functions with your 
data. If you have Excel (or Numbers, on a Mac) installed on your computer, the 
data open in Excel.
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9 Maintenance and 
Specifications

Cleaning the Sample Trays
Clean the sample trays with standard laboratory detergents or mild solvents 
such as EtOH or MeOH. Use lint-free tissue to wipe them dry. Dust particles or 
lint on a sample tray can glow under UV illumination.

UV-B Fluorescent Lamp Replacement
The UV-B lamps provide service under normal usage for 4–5 years. In case of 
a lamp failure, one of the following error messages appears:

• Fault in UV bulbs Bank 1&2 
• Fault in UV bulbs Bank 1 
• Fault in UV bulbs Bank 2

To replace the lamps:
1. Turn off the instrument and unplug the AC cord. 

2. Remove and save the seven screws around the outside edge of the 
imager back. Do not remove the screw at the bottom left outside corner 
of the imager back.

3. Carefully slide the top cover toward the back of the instrument until it is 
all the way off. 
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4. On the left side of the instrument a single screw holds the lamp 
assembly in place. Remove and save this screw. 

5. Carefully slide out the lamp assembly. Although only one lamp bulb may 
be out, it is recommended that all lamps be replaced to ensure even 
illumination and to reduce the need to access the lamps again.

6. Replace all lamps with UV-B fluorescent lamps (Bio-Rad part catalog 
#900-0217). Make sure each lamp is properly seated in its holder.

7. After replacing all the lamps, carefully slide the lamp assembly back into 
the instrument. Press on the side of the lamp assembly to the right of 
the screw hold-down tab, to make sure it is fully seated into the 
instrument. If the lamp assembly is not fully seated, the following error 
message appears the next time it communicates with Image Lab 
software: Light tray not detected.
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Error Messages
Sample tray not detected 

The sample tray has a magnet that senses when the sample tray is inserted. If 
you attempt to image and this message appears, the sample tray may not be 
pushed in all the way. Press the tray in until the magnet grabs the tray.

Light tray not detected 

This error message appears if the lamp assembly is not fully seated into the 
imager. Reseat the lamp assembly as described on the previous page.

Door was opened during imaging

To prevent UV radiation exposure, the UV-B lamps do not turn on unless the 
front sample tray door is fully closed. This message also appears when the 
instrument cover has been removed.
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Technical Specifications
Hardware Specifications

Image area 15 x 11.2 cm

Excitation source Trans UV B (302 nm peak)

Detector Charge-coupled device

Image pixel size 107.8 x 107.8 μm (in microns)

Dynamic range 3.0 orders of magnitude

Pixel density 4,096 gray levels

Flat fielding Yes

Instrument size 43 x 28 x 38 cm

Instrument weight 7.3 kg

Connector descriptions USB-A connector is used for communication with a PC 
USB-B connector is used for the instrument interface

Software Specifications

Operating system 
compatibility

Windows XP SP3 or higher
Windows 7 (32- and 64-bit)

Mac OS 10.5 or 10.6

Image file size Approximately 2.5 MB

Computer interface USB 2.0

Operating Ranges

Operating voltage 110/115/230/240 VAC Nominal

Operating temperature 10–28°C (21°C recommended)

Operating humidity < 70% noncondensing

Equipment Ratings

Input voltage range 100–240 VAC 
Input frequency range 50–60 Hz

Power 40 W

The Gel Doc EZ imager is for indoor laboratory use only.

Automation Capabilities

Workflow automated 
execution

Controlled by a protocol via setup for gel activation, image 
capture, analysis, and reporting

Workflow reproducibility 100% repeatability via recallable protocols, from gel activation 
and image capture to quantitative analysis and reports

Autoexposure 2 user-defined modes (intense or faint bands)
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A. Using the Criterion Stain 
Free™ System
The Criterion Stain Free system comprises the Gel DocTM EZ imager, Image 
Lab™ software, and three types of precast gels:

• Criterion™ TGX Stain-Free™
• Criterion Stain Free 

• Mini-PROTEAN® TGX Stain-Free™ 

The Stain Free system eliminates the time-consuming staining and destaining 
steps required by other protein detection methods. Stain Free gels include 
unique trihalo compounds that allow rapid fluorescent detection of proteins 
with the Gel Doc EZ imager—without staining. 

The trihalo compounds in the gels react with tryptophan residues in a UV 
light–induced reaction to produce fluorescence, which can be easily detected 
by the Gel Doc EZ imager within gels or on low-fluorescence PVDF 
membranes. Activation of the trihalo compounds in the gels adds 58 Da 
moieties to available tryptophan residues and is required for protein 
visualization. Proteins that do not contain tryptophan residues cannot be 
detected using this system. The sensitivity of the Stain Free system is 
comparable to staining with Coomassie Brilliant Blue for proteins with a 
tryptophan content >1.5%; sensitivity superior to Coomassie staining is 
possible for proteins with a tryptophan content >3%.

Benefits of the Stain Free system include:
• Elimination of staining and destaining steps for faster time to 

results
• No background variability within a gel or between gels (as is often 

seen with standard Coomassie staining)
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• Elimination of the need for acetic acid and methanol in staining and 
destaining, reducing organic waste

• Visualization of transferred or blotted proteins on low-fluorescence 
PVDF membranes

Stain Free Workflow
For detailed information about workflow steps, refer to the Criterion™ Precast 
Gels Instruction Manual and Application Guide or to the Mini-PROTEAN® 
Precast Gels Instruction Manual and Application Guide except where 
otherwise noted.

Electrophoresis with Stain-Free Gels
Stain Free gels are made and packaged without SDS so they can be used for 
both SDS and native PAGE applications.

To perform electrophoresis with these gels, prepare the sample and running 
buffers, set up the electrophoresis cell, and perform the run.

See Chapter 4, Acquiring Images

Prepare Buffers

Prepare Gels and Assemble
Electrophoresis Cell

Prepare and Load Samples

Perform Electrophoresis

Activate/Image Gels

Analyze the Separation
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Imaging Gels
Use unstained standards with Stain Free gels, as some prestained standards 
are not detected by the Stain Free system. To monitor electrophoresis, use a 
1:1 mixture of unstained and prestained standards.

Setting up a protocol for Stain Free gels is in many ways the same as setting 
up protocols for other applications. Follow the instructions in Setting Up a 
Default Protocol, on page 33 but after step 3, set the activation options for the 
gel as follows.

Set the activation options: Visualizing proteins requires activation of the gel. 

Choose an activation time option based on your 
sample and the purpose of your experiment:

• Use 2.5 min activation when samples are 
abundant and when a fully optimized signal-
to-noise ratio is not necessary

• Use 5.0 min activation for detection of proteins 
that are in low concentration and for the best 
quantification of the maximum number of 
bands. Because the reaction is near completion after 5 min, this 
method offers an optimal signal-to-noise ratio

Note: If the gel has already been activated for 2.5 min, activating 
it for another 2.5 min may improve it; but activating an image for 
more than 5 min will not.

Continue setting up the protocol at step 4, Set the image exposure, on 
page 36.

Imaging Blots
To blot Stain Free gels, use standard blotting procedures as described in the 
instruction manual you are using. Use only PDVF membranes with low 
background fluorescence, as membranes other than low-fluorescence PDVF 
can result in high background or low sensitivity with the Gel Doc EZ imager.

To assess transfer efficiency, be sure to activate and visualize the gel using the 
Gel Doc EZ imager before transfer.
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B. Regression Calculation 
Methods
Each regression method calculates a standard curve. Some of the methods 
provide the formula for the standard curve. In this case, the molecular weight 
can be calculated by:

x = relative front of the band of interest

y = molecular weight of the band of interest 
 
Linear (semilog): The linear equation is y = a + bx, where a is the intercept 
and b is the slope of the line. 

NOTE: The linear equation is calculated on the log of the 
molecular weight values.

The R2 value may be used to determine the overall quality of the linear fit. A 

linear regression with an R2 value of >0.99 is considered a very good fit. The 
primary advantage of this method is that it is extremely simple. The primary 
disadvantage is that it will deliver incorrect results if the data are not very 
linear.

Point-to-Point (semilog): No single equation is available for the point-to-
point method. The slope of each segment of the curve between data points is 
calculated independently.

NOTE: The log of the molecular weight values is used to calculate 
the slope for each segment of the curve.

Logistic: The Logistic-4PL equation is
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where:

x = mobility

y = molecular weight

a = estimated molecular weight at infinity

b = slope of the tangent at midpoint

c = midpoint

d = estimated molecular weight at zero mobility

Since the curve generated by the logistic-4PL regression method represents a 
perfectly shaped S, it might not fit the data very well in all cases.

Cubic spline: Cubic spline curves are smooth curves that go through every 
data point. The model is a cubic polynomial on each interval between data 
points. In some cases, a spline curve can work well as a standard curve for 
interpolation. However, because the curve is calculated individually for every 
pair of points, it does not correspond to any single equation.
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C. Troubleshooting

Problem Possible Cause Solution

Green LED on front panel is 
off

AC power cord is not 
connected

Connect AC power cord to the imager and an 
appropriate wall socket

Power is off Turn the power switch on

Front panel LEDs remain 
flashing

Firmware is not loading Call Bio-Rad Technical Support for help

Image is not visible on the 
monitor

No sample on sample tray Place a sample on the tray and run the protocol 
again

Image is not bright enough Underdeveloped gel If initially stopped after 2 min, allow the gel to 
develop for 2–3 more min

Red LED flashing on front 
panel 

Sample tray not inserted all 
the way

Push the sample tray into the imager until the 
magnet pulls the sample tray

Door interlock broken Close the door

Bulb fault Replace all the lamps according to the 
instructions in Appendix A

Communication interrupted Make sure imager power is on and the USB cable 
is connected to the PC. Restart the imager

Imaging button is pressed 
on front panel while 
software is not running

The red light stops flashing when the software is 
opened. Press the imaging button again to 
initiate imaging



Gel DocTM EZ System | Troubleshooting

104



Thermal Printer Settings

105

D. Mitsubishi P93/P95 
Thermal Printer Settings

Windows
The printer driver can be found on the Image Lab™ software installation CD in 
the Misc directory. 

To set up a thermal printer on a Windows system:

1. Install the printer driver. 

2. Open the printer section in Control Panel.

3. Click the thermal printer icon and select Printing Preferences.
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4. Configure the correct paper size: select 1280 x 1280.

5. Click OK to apply your changes.

Mac
The printer driver can be found on the Image Lab software installation CD in 
the Misc directory. 

To set up a thermal printer on a Mac system:

1. Install the printer driver.

2. Connect the printer to the computer.

To configure the correct paper size:

1. Start Image Lab software.

2. Select FIle > Page Setup.
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3. In the Settings drop-down list, select Page Attributes.

4. In the Format For drop-down list, select the Mitsubishi printer.

5. In the Paper Size drop-down list, select 1280 x 1280.

6. In the Settings drop-down list, select Save as Default. 

7. Click OK to save the settings.
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Glossary

CCD: Charge-coupled device. A light-sensitive silicon chip used as a 
photodetector in digital camera systems. 

Colormaps:  Different color representations of a gel image.

Electrophoresis: A technique for separating molecules based on the 
differential movement of charged particles through a matrix when subjected to 
an electric field.

EtOH: Ethanol.

Example precision: The number of decimal places chosen for a 
measurement.

Flat fielding: An average intensity computation that compensates for 
nonuniformities generated by an instrument.

Histogram: Representation of the brightness, or gray value, of an image 
as a graph.

MeOH: Methanol.

Quantitative imaging: Determines the quantity of a protein’s 
components through analysis of the pixel values in a digital image of the 
sample.

Relative quantity: A measurement of a specific band’s relative 
quantity to the total of all identified bands within a given lane.

SDS: Sodium dodecyl sulfate (sodium lauryl sulfate); a denaturant that 
provides a negative charge.

SDS-PAGE: Polyacrylamide gel electrophoresis performed with the 
denaturant sodium dodecyl sulfate.

Tris: Tris(hydroxymethyl)aminomethane; a buffer component.

Tryptophan: An essential amino acid that is a precursor of important 
biochemical molecules indoleacetic acid, serotonin, and nicotinic acid.
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UV-B: The range of ultraviolet light used by the Gel DocTM EZ system.

UV transilluminator: The part of the Gel Doc EZ imager that 
transmits UV light through a sample.
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Index

A
Absolute quantity 75
Absolute volume 83
Acquisition settings 33, 35
Activation options

Stain Free gel 99
Adding annotations to gel images 78
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changing orientation 57
copying to clipboard 92
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Analyze image 37
Analyze molecular weight 39
Analyzing

molecular weight 72
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Applications

blue tray 4
molecular weight assessment 5
quantification 5
Stain Free tray 4
UV tray 4
white tray 4

B
Background subtraction

global 82
lane-based 69
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Blots

merging images 66, 67
Blotting Stain Free gels 99
Blue tray

applications for 4

C
CCD

defined 109
Colormap

changing 53
Creating a custom application 46
Creating a custom protocol 45
Crop tool 66
Cubic spline

defined 102
Cubic spline regression method 76
Custom application
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creating 46

D
Dark image 12, 29
Default protocol

running 20, 44
Default protocol button

defined 23
Detect lanes and bands 37
Display gel options 50

E
Editing protocols 48
Electrical standard 5
Electrophoresis

defined 109
EMC regulations 5
Error messages 95

lamp replacement 94
Exporting

analysis tables 92
lane and band tables 91
results 89
volume tables 91

Exporting gel images 89
for publication 90
image files for analysis 91
to PulseNet International 91

F
Fit in Window

resizing Results files 51
Flat field 29
Flat fielding

defined 109
Fluorescent lamp

replacing 93

G
Gel

protocol for Stain Free gel 99
setting activation options 99

Gel Doc EZ imager
described 3

Gel image
adding annotations 78
adjusting brightness and contrast

52
exporting 89

Gel image, adjusting irregular 69
Gel imaging 35
gels 99
Global background subtraction 82

H
Histogram 53

I
Image

resizing 51
Image colors

changing colormaps 53
Image contrast

setting 52
Image information

viewing 54
Image tools 66
Image Transform

set image contrast 52
Imaging process overview 20

L
Lane

background subtraction 69
detecting 68

Lane and band tools 68
Linear regression method 76
Local background subtraction 82



M
Merging blot images 66, 67
Molecular weight analysis tools 72

standard 72

N
Nucleic acid gels

applications for 32

P
Point-to-Point regression method 76
Printing reports 88
Protein gels

applications for 32
Protein standards

selecting 39
Protocol

creating custom 45
defined 19
editing 48
for Stain Free gel 99
opening 48
renaming 48
reusing 45, 47
summary 43

Protocol file
compared to results file 19
defined 19

Protocol settings
reviewing 43

Q
Quantity tools 73

R
Regression methods

cubic spline 76
linear 76
point-to-point 76

Relative quantity 73

Relative volume 83
Relative volume quantity 83
Renaming a protocol 48
Report 85

adjusting printer settings 88
generating 85
printing 88
printing to .pdf file 88

Resizing images 51
Resources and references ii
Results

exporting 89
Results file

compared to protocol file 19
resizing 51
viewing as 3D projection 54
viewing as lane profile 59
viewing image information 54

Reviewing
protocol settings 43

Rolling disk 69
Running a protocol 48

S
Safety 5
Sample tray

cleaning 93
Saturated pixel 37
Screenshot tool 23, 29, 92
Setting image contrast 52
Setting up

default protocol 33
Simulation mode

and protocols 33
Software

installing drivers 9
Specifications, technical 96
Stain Free application

setting activation options 36
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